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Introduction
This manual describes how to use “Stream Weaver” to transform an application into the 
StreamFlow stream format. Additionally, it provides a description of the test environment 
for streamed applications.

What is StreamFlow Application 
Streaming?

StreamFlow Application Streaming is a secure method to access and run applications that 
does not require application installation or application removal. Applications are virtually 
installed and available on an on-demand basis over the Internet and/or corporate network.

The benefits of streamed applications are many - Centralized application management, 
access to more applications, instant upgrades, lower application management costs, 
reduced licensing compliance complexities, and controllable application access are just a 
few benefits.

What is Stream Weaver?
Stream Weaver is a software tool that encodes a Microsoft Windows®-based PC 
application into a network/Internet streamable format to take advantage of the streaming 
benefits. All that is required to use Stream Weaver is a PC running Windows® XP or 
Windows® Vista and the installer for the application to be encoded.
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Development Environment
To transform an application into a streamed application, at least two PCs are required. One 
should be a Windows® XP or Windows® Vista system for Stream Weaver processing of 
the application and the other a PC with any supported Windows® target operating system 
for testing the streamed application. There can be a separate PC for each target operating 
system or there can be a single testing PC that is re-imaged for each operating system.

“Imaging” is taking a snapshot of a PC’s hard drive so that an exact duplicate of a PC’s 
configuration can be restored to the PC. “Re-imaging” is using the snapshot of the PC to 
restore the PCs configuration. This is much more efficient and reliable than reloading the 
operating system, drivers, support programs, and removing unneeded applications.

Target Audience
This manual is written for a technician or engineer who is responsible for processing 
Windows®-based PC applications into a format that can be streamed over the Internet 
and/or corporate networks using Stream Theory®’s Stream and Token servers.  The 
Stream Weaver tool is designed to process Windows®-based PC applications that have a 
standard application installer.  For applications without an installer, a different tool is 
recommended: Stream Weaver Professional (available in the future) is designed for 
application developers that desire to transform their applications into a streaming format.

Recommended Technical Knowledge
Following is a list of recommended technical knowledge for making the best use of this 
guide and troubleshooting applications:

• Installing Applications
• Hardware drivers
• Windows Registry

Guide Organization
This guide is organized as follows:

• Introduction
• Chapter 1 - System Requirements
• Chapter 2 - Using Stream Weaver
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• Appendix A - Applying Patches and Updates
• Index

Typographic Conventions
The following typefaces are used throughout this guide:

The following icons are used throughout this guide:

A note icon identifies information of which you should be aware.

Bold text Names of windows, dialog boxes, menus, commands, 
buttons, predefined folders, and keyboard keys.
Examples: Click on OK. Press Enter. Navigate to the My 
Documents folder.

italic text Indicates references to a chapter or section within this 
guide or other documentation. Also used to emphasize 
new terms.
Example: Refer to the Stream Theory Player Users Guide 
for further information.

> symbol Sequence in which you should select a menu option.
Example: File > New > Document means click on the 
File menu first, then click on New, and then click on Doc-
ument. 

1, 2, 3 Numbered items indicate sequential steps in a procedure. 
Sub steps are indicated with indented bullets. Relevant 
graphics or screen captures may follow steps. 

Screen captures The screen captures in this guide are examples only. 
Your software is configured according to your Company’s 
requirements. Therefore, the sample screens used in this 
guide may not exactly match the user interface on your 
system.
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! CAUTION
This icon identifies information about actions that might cause problems within the 
application, with the system or with your data, including data loss.

Obtaining Technical Support
Endeavors Technologies provides a number of convenient ways to obtain technical 
support as described below.

Web Site
Support information is available online on the following Endeavors Technologies web 
site:

http://support.endeavors.com.

Email
You can request technical support by sending us email to support@endeavors.com. Our 
support staff will address your email questions in a timely manner.

Telephone
You can obtain telephone support by calling 1-866-277-9411 Monday through Friday 
between the hours of 9 a.m. and 6 p.m. Pacific time (PST).

After Hours Support
For support outside of regular business hours (Monday through Friday, 9 a.m. to 6 p.m. 
Pacific time) you can contact Endeavors Technologies via email. Email received outside 
of the hours noted above will be addressed on the next business day.

Sales
For sales or related information about StreamFlow, visit our web site 
(www.endeavors.com), call us at 1-866-624-4727, or send email to 
sales@endeavors.com.

http://www.endeavors.com/support.html
http://www.endeavors.com/support.html
http://www.endeavors.com/support.html
http://www.endeavors.com/
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StreamFlow Server License Agreement
END USER LICENSE AGREEMENT FOR ENDEAVORS TECHNOLOGIES 
SOFTWARE

ENDEAVORS TECHNOLOGIES, INC. ("LICENSOR") IS WILLING TO 
LICENSE THIS SOFTWARE TO YOU, THE "LICENSEE", ONLY UPON 
THE CONDITION THAT YOU ACCEPT THE TERMS CONTAINED IN THIS 
LICENSE. BY ACCEPTING THESE TERMS, YOU ARE INDICATING THAT 
YOU HAVE READ ALL OF THE TERMS AND CONDITIONS OF THIS 
AGREEMENT AND ANY ADDITIONAL TERMS AND CONDITIONS 
CONTAINED HEREIN, UNDERSTAND THEM, AND AGREE TO BE 
BOUND BY THEM. IF YOU DO NOT AGREE TO OR UNDERSTAND ALL 
THESE TERMS, THEN LICENSOR IS UNWILLING TO LICENSE THE 
SOFTWARE TO YOU. 

1. Definitions (as used in this Agreement):

(a) "Software" means all software, in object code only, provided by Licensor to 
you, together with the authorization key contained in the Security device, and all 
Licensor-authorized updates, replacements or modifications provided to you.

(b) "Documentation" means the user guides, reference manuals, installation 
materials and other written materials (in whatever format, including electronic or 
hardcopy) relating to the System which Licensor provides to you.

(c) "Security device" means the Software "authorization key" packaged by 
Licensor with the Software (or any Licensor-authorized replacement provided to 
you) and which contains a unique series of data elements which enables the use 
of the Software.

(d) "System" means a system furnished by Licensor and comprised of Software, 
Security device, and related Documentation.
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2. Limited Use License 

(a) Subject to the terms and conditions contained in this Agreement, Licensor 
grants, and you accept, a non-exclusive, non-transferable (except as provided 
below) license, without the right to sublicense, and right (i) to use the Software 
only on a single computer, and (ii) to use the Documentation, in each case for 
your internal purposes only. The Software may only be used by a single user at 
any time, and may not be used as a networked application. Additional concurrent 
users will require additional licenses for the Software. You may physically 
transfer the Software from one computer to another provided that the Software is 
used on only one computer at a time. Additionally, you may not distribute copies 
of the Software or the accompanying Documentation to others nor may you 
modify or translate the Software or Documentation. You may not transfer the 
Software or this license, except in compliance with Licensor's license transfer 
procedures, which among other things require the transferee prior to such transfer 
to agree in writing to be bound by your obligations hereunder, and may in some 
jurisdictions require the payment of a transfer fee.

(b) Notwithstanding the foregoing, you may license the System to a third party 
for a temporary, defined period provided: (i) you may not license the Software 
separate from the Security device; (ii) you remain responsible for all of your 
obligations hereunder; (iii) you ensure that each such third party complies with 
all obligations hereunder; (iv) you notify Licensor on request of the location of 
the System; and (v) you indemnify, defend and hold Licensor harmless from and 
against any claims or liabilities that may arise from your rental of the System.

(c) You will take all reasonable steps to safeguard the Software, and the 
Documentation and to ensure that no unauthorized persons have access to the 
Software or the Documentation, and that no persons authorized to have such 
access shall take any action which would be prohibited by this Agreement if 
taken by you. You will not, directly or indirectly, reverse engineer, disassemble, 
decompile or otherwise alter the Software (including but not limited to the 
Security device); provided, however, that (i) if you are located in the European 
Union or Norway, if reproduction of the code and translation of its form are 
necessary to obtain the information required to achieve the interoperability of the 
Software with other programs, you shall inform Licensor in writing accordingly 
and Licensor shall notify you within twenty (20) business days from receipt of 
your request that: (A) Licensor will perform the work in order to achieve such 
interoperability and charge you a reasonable expense allowance for such work, or 
(B) you yourself are entitled to undertake those actions, but only to the extent 
required to achieve the interoperability of the Software with other programs; and 
(ii) if you are not located in the European Union or Norway, this Section 2(c) 
gives you specific legal rights, and you may also have other rights which vary 
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from jurisdiction to jurisdiction. You will include and will not alter or remove 
any copyright, patent, trade secret, proprietary and/or other legal notices 
contained on or in the System, including the Software, Security device, or the 
Documentation. The existence of any such notices on or in the System shall not 
be construed as an admission that publication has occurred.

(d) You acknowledge that the Software may include features that ensure that your 
use of the Software complies with the terms of this Agreement.

(e) The Software may be accompanied by a Security device, which contains an 
"authorization key." An authorization key is a unique series of data elements 
which enables you to access and use the version of the Software licensed to you. 
Such keys are confidential and non-transferable and must be returned or 
destroyed by you upon termination of this Agreement, as provided in Section 11.

(f) This license is limited to the version of the Software (including features) 
originally approved by Licensor to be licensed to you, as accessed through the 
applicable Licensor-configured Security device (or any Licensor-authorized 
replacement). This license does not extend to any other version, even if such 
version may be part of the Software, and access to such versions may only be 
accomplished through a separate Licensor-authorized license accompanied by a 
separate Licensor-authorized Security device or other authorization key. You 
acknowledge that it is a breach of this license for you, or anyone acting on your 
behalf, to modify or alter the Security device configuration to access any version 
of the Software not originally licensed to you, or to use with the Software any 
other Security device or authorization key not originally supplied with the 
Software (or any Licensor-authorized replacement).

(g) If you are licensing the System from the licensee who obtained the System 
from Licensor, you shall be bound by all the terms and conditions of this 
Agreement to the same extent as such licensee; provided, however, that (i) 
Licensor makes no warranties to you under Section 7 below; (ii) you shall not be 
entitled to any Software maintenance and support, if any, provided by Licensor 
under Section 8 below; and (iii) you shall have no right to relicense the System to 
any other parties.

(h) In addition to the Software, Licensor may provide with the System certain 
third party software (such as plug-ins) to be used at your own option (the "Third 
Party Software"). If you decide to use such Third Party Software, your use shall 
be governed by any applicable third party's license agreement provided to you, an 
electronic copy of which will be installed in the appropriate product folder on 
your computer upon installation of the Third Party Software. LICENSOR AND 
ITS RESELLERS, DISTRIBUTORS AND LICENSORS ARE NOT 
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RESPONSIBLE FOR SUCH THIRD PARTY SOFTWARE AND SHALL 
HAVE NO LIABILITY FOR YOUR USE OF IT. Where no such agreement is 
provided to you separately, your use shall be governed by this Agreement.

3. Title. This Agreement is not a sale of the Software, the Documentation or any 
copy thereof. Licensor and its licensors retain all rights, title, interest, and 
ownership of the Software and the Documentation, including patents, copyrights, 
trademarks, trade secrets and other proprietary rights applicable thereto, and all 
copies, regardless of the form or media on or in which the original or any copy 
may exist. The Software and the Documentation are protected by United States, 
Canadian and other applicable laws and by international treaty provisions. 
Except as stated herein, this Agreement does not grant you any rights to patents, 
copyrights, trade secrets, trademarks or any other rights in respect of Software, 
Hardware, and Documentation. 

4. Restrictions on Copying. You are hereby licensed to make one copy of the 
Software in machine-readable form solely for backup purposes, provided that 
you include and not alter or remove any copyright, patent, trade secret, 
proprietary and/or other legal notices contained on or in the Software or 
Documentation. All copies or partial copies of the Software or Documentation, 
whether in printed, machine-readable or other form, shall be considered part of 
the Software or Documentation and shall be subject to this Agreement. Except as 
expressly provided herein, you may not copy, nor encourage or allow copying of, 
the Software or Documentation. You may not cause or permit the disclosure, 
copying, licensing, sublicensing, leasing, dissemination or other distribution of 
the Software or the Documentation by any means or in any form, without the 
prior written consent of Licensor. You may not use the Software to conduct a 
service bureau, ASP business or similar business for the benefit of third parties. 

5. Confidentiality. You acknowledge that the System contains proprietary and 
confidential property of Licensor and/or Licensor's licensors embodying trade 
secrets (collectively, "Confidential Information"). You will not disclose, provide 
or otherwise make available any such Confidential Information to any person 
other than your employees and/or consultants who need to have access thereto to 
carry out their duties and who are bound by appropriate confidentiality or 
nondisclosure agreements.

6. Government End Users. U.S. GOVERNMENT RESTRICTED RIGHTS. The 
System was developed at private expense and with no government funds. If any 
Software or Documentation is acquired by or on behalf of a unit or agency of the 
U.S. Government, the Government agrees that such Software or Documentation 
is "commercial computer software" or "commercial computer software 
documentation" and that, absent a written agreement to the contrary, the 
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Government's rights with respect to such Software or Documentation are limited 
by the terms of the this License Agreement, pursuant to U.S. Federal Acquisition 
Regulations Section 12.212(a) and/or Defense Federal Acquisition Regulations 
Supplement Section 227.7202-1(a), as applicable. The Software is proprietary 
data, all rights of which are reserved under the copyright laws of the United 
States, Canada and other countries.

7. Limited Warranty. 

(a) Licensor warrants solely to you that the System, unmodified by you, will 
function substantially in accordance with Licensor's published specifications for 
the period(s) set forth in the applicable warranty policy in effect at the time of 
licensing when given normal, proper, and intended usage, provided that you 
implement all releases, enhancements and corrections previously offered to you 
by Licensor. This warranty does not apply to expendable components, such as, 
but not limited to, computer diskettes and tapes. Your sole remedy and Licensor's 
exclusive liability for a breach of this limited warranty shall be, at Licensor's 
option, the repair or replacement of the non-conforming System. LICENSOR 
AND ITS RESELLERS, DISTRIBUTORS AND LICENSORS DO NOT 
WARRANT THAT YOUR USE OF THE SYSTEM WILL BE 
UNINTERRUPTED OR ERROR-FREE. 

(b) If Licensor determines that the System, or the component parts thereof, for 
which you have requested warranty service are not eligible for warranty service, 
You will pay or reimburse Licensor for all reasonable costs of investigating and 
responding to such request at Licensor's then prevailing time and materials rates. 
If Licensor provides repair service or replacement parts that are not covered by 
the warranty provided in this Section, you will pay Licensor at Licensor's then 
prevailing time and materials rates. 

(c) Licensor shall have no obligation to provide warranty or maintenance service 
in respect of claims resulting, in whole or in part, from (i) catastrophe, fault or 
negligence, (ii) improper or unauthorized use or repair of the System, (iii) use of 
any System in a manner for which it was not designed, (iv) causes external to the 
System such as, but not limited to, power failure or electric power surges, or (v) 
use of the System in combination with equipment or software not supplied or 
approved by Licensor.

(d) Notwithstanding the above, no warranty shall apply to Hardware, Software or 
Documentation which is designated as "beta," "limited release," "pre-release," or 
otherwise as not being subject to warranty. All such Hardware, Software and 
Documentation is provided "AS IS" AND WITH ALL FAULTS. IN ADDITION, 
NO WARRANTY APPLIES TO LOST OR STOLEN SECURITY DEVICES. 
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YOU ARE ADVISED TO INSURE YOUR SECURITY DEVICES AGAINST 
LOSS OR THEFT.

(e) EXCEPT AS STATED ABOVE, LICENSOR AND ITS RESELLERS, 
DISTRIBUTORS AND LICENSORS EACH DISCLAIM, TO THE 
MAXIMUM EXTENT PERMITTED BY LAW, ALL WARRANTIES OR 
CONDITIONS, WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, 
STATUTORY OR OTHERWISE, WITH RESPECT TO THE SYSTEM (OR 
ANY COMPONENT PARTS THEREOF), ANY THIRD PARTY SOFTWARE, 
INCLUDING ANY AND ALL WARRANTIES OF TITLE, NON-
INFRINGEMENT OF THIRD PARTY'S RIGHTS, QUALITY, 
PERFORMANCE, MERCHANTABILITY, AND FITNESS FOR A 
PARTICULAR PURPOSE. Some jurisdictions do not allow limitations on 
disclaiming implied warranties or conditions, so the above limitation may not 
apply to you.

(f) If you have questions about performance of this product, or this limited 
warranty, you can contact Licensor at Endeavors Technologies, Inc., 19600 
Fairchild Road, Suite 350, Irvine, California 92612 USA (or such other address 
as Licensor may make available from time to time), or visit www.endeavors.com 
to obtain information on limited warranty performance.

(g) This limited warranty gives you specific legal rights, and you may also have 
other rights which vary from jurisdiction to jurisdiction. Some jurisdictions do 
not allow the exclusion or limitation of relief, incidental or consequential 
damages, so the above limitation or exclusion may not apply to you.

8. Software Maintenance (This Section 8 is applicable only if Licensor provides 
maintenance). Software maintenance charges and options are specified by 
Licensor from time to time. In the event you purchase Software maintenance, 
such maintenance shall be subject to the terms and conditions effective on the 
date of such purchase, and Licensor shall provide the following, plus options, if 
any, which you purchase, effective immediately upon expiry of the applicable 
warranty period:

(a) You will receive one copy of maintenance releases to the Software and 
Documentation if and as they are generally made available at no additional 
charge to Licensor customers which have purchased Licensor software 
maintenance. Maintenance releases may contain minor functional enhancements 
and corrections. Maintenance releases do not include upgrades or major product 
releases.

(b) Licensor will use reasonable efforts, including by means of a workaround or 
telephone hot-line support, to cause Software not covered by Licensor's warranty 
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to perform substantially in accordance with specifications after having been 
notified by you of non-performance. If Licensor is unable to cause such Software 
to perform substantially in accordance with such specifications, then your sole 
remedy and Licensor's exclusive liability is a pro rata refund of the fees you paid 
for such maintenance for the remainder of the then-current maintenance period.

(c) Subject to your having entered into a maintenance and support agreement 
with Licensor, Licensor will provide maintenance only on the then most current 
and one immediately prior version of the Software. Licensor's obligation to 
provide maintenance shall be conditioned on your: using only Licensor-approved 
products and maintaining the correct operating environment in accordance with 
requirements stipulated in the applicable System specifications; designating one 
of your employees at each site to be Licensor's single service contact and 
allowing Licensor reasonable access to the System and necessary data; promptly 
installing all changes and/or updates furnished by or on behalf of Licensor; 
notifying Licensor in writing prior to relocating the System to a permitted 
location other than the site at which the System is then-currently installed; and 
being current in all payments to Licensor.

(d) In the event you request a field visit to perform maintenance or warranty 
services, you agree to pay Licensor its then-current charges associated with field 
visits. 

(e) EXCEPT AS STATED ABOVE, LICENSOR AND ITS RESELLERS, 
DISTRIBUTORS AND LICENSORS EACH DISCLAIM, TO THE 
MAXIMUM EXTENT PERMITTED BY LAW, ALL WARRANTIES OR 
CONDITIONS, WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, 
STATUTORY OR OTHERWISE, WITH RESPECT TO SUCH 
MAINTENANCE, INCLUDING ANY AND ALL WARRANTIES OF NON-
INFRINGEMENT OF THIRD PARTY'S RIGHTS, QUALITY, 
PERFORMANCE, MERCHANTABILITY, AND FITNESS FOR A 
PARTICULAR PURPOSE.

9. Limitation of Liability. THE MAXIMUM LIABILITY OF LICENSOR AND 
ITS RESELLERS, DISTRIBUTORS AND LICENSORS ARISING OUT OF 
THE SALE/LICENSE OF THE SYSTEM OR THE USE THEREOF OR THE 
PROVISION OF MAINTENANCE, WHETHER BASED UPON WARRANTY, 
CONTRACT, TORT OR OTHERWISE, SHALL NOT EXCEED (A) WHERE 
THE CLAIM RELATES SOLELY TO THE SYSTEM, THE ACTUAL 
PAYMENT MADE BY YOU FOR THE SYSTEM; (B) WHERE THE CLAIM 
RELATES SOLELY TO MAINTENANCE, THE AMOUNTS PAID BY YOU 
FOR MAINTENANCE IN THE TWELVE MONTH PERIOD PRIOR TO THE 
DATE OF THE CLAIM; OR (C) WHERE A CLAIM RELATES BOTH TO 
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THE SYSTEM AND MAINTENANCE, THE AMOUNTS PAID BY YOU 
DURING THE LAST TWELVE MONTH PERIOD PRIOR TO THE DATE OF 
THE CLAIM WITH REGARD TO THE SYSTEM AND MAINTENANCE. 
Some jurisdictions do not allow the limitation of liability to specified amounts, so 
the above limitations may not apply to you.

10. Exclusion of Damages. IN NO EVENT SHALL LICENSOR AND ITS 
RESELLERS, DISTRIBUTORS AND LICENSORS BE LIABLE FOR 
SPECIAL, INCIDENTAL, PUNITIVE, INDIRECT OR CONSEQUENTIAL 
DAMAGES, OR FOR LOSS OF DATA OR LOSS OF USE DAMAGES 
(INCLUDING WITHOUT LIMITATION "DOWNTIME") AND LOST 
PROFITS, ARISING HEREUNDER OR FROM THE SALE OF THE SYSTEM 
OR THE LICENSE OF THE SOFTWARE AND DOCUMENTATION OR THE 
USE OF ANY OF THEM OR THE PROVISION OF MAINTENANCE OR 
ANY DELAY OR FAILURE TO DELIVER THE SYSTEM OR 
MAINTENANCE, EVEN IF LICENSOR OR LICENSOR LICENSORS HAVE 
BEEN ADVISED OF THE POSSIBILITY OF ANY SUCH DAMAGES. Some 
jurisdictions do not allow the exclusion or limitation of incidental, consequential, 
special, punitive or indirect damages, so the above limitation or exclusion may 
not apply to you.

11. Term. This Agreement is effective until terminated. You may terminate the 
license at any time by returning the Software and all Documentation to Licensor 
and by removing the Software and all copies thereof from the memory of any 
computer into which the Software has been transferred. This Agreement shall 
terminate automatically if you fail to comply with any term or condition 
contained herein. Within seven days of Licensor's termination of this Agreement, 
you will return to Licensor the original and all copies of the Software and the 
Documentation. Any Software you are required to return hereunder includes 
circuit boards containing Licensor proprietary software, firmware, or other 
technology. The Security device (which contains proprietary authorization keys) 
shall also be returned to Licensor, or, at Licensor's option, you may destroy it and 
certify to Licensor that it has been destroyed.

12. Export. 

(a) You acknowledge that the Software, Hardware, Documentation and/or 
technical data associated therewith ("Technical Data") are subject to the export 
control laws of the United States. You agree that you shall comply with all 
applicable U.S. export control laws and regulations, and shall not export or re-
export the Software, Hardware, Documentation and/or Technical Data, or direct 
products thereof, except as authorized by U.S. law.
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(b) Without limiting the foregoing, you acknowledge that you are not a person or 
entity prohibited from receiving U.S. exports or a person or entity which engages 
in the development, production, or stockpiling of missiles or nuclear, chemical, 
or biological weapons. You further acknowledge that (i) you are not located in, 
and (ii) you are not a national of any country that is restricted or embargoed by 
the United States government or for which an export license is required under 
regulations promulgated by the U.S. Department of Commerce.

(c) You agree not to export, re-export, or otherwise disclose the Software, 
Hardware Documentation and/or Technical Data to any national of the above-
listed countries, or to any other person or entity prohibited from receiving U.S. 
exports or to any entity which engages in the development, production, or 
stockpiling of missiles or nuclear, chemical, or biological weapons.

(d) Without limiting any of the foregoing, in the event you export the Software, 
Hardware, Documentation or Technical Data from the country in which you first 
received it, you assume the responsibility for compliance with all applicable 
export and re-export regulations, as the case may be.

13. Respect for Rights and Indemnification. You agree that you shall only use the 
Software and Documentation in a manner that complies with all applicable laws 
in the jurisdiction in which you use the Software and Documentation, including 
but not limited to, applicable restrictions concerning copyright and other 
intellectual property rights. This Software is intended for use only with properly 
licensed media, content, and content creation tools. It is your responsibility to 
ascertain whether any copyright, patent, or licenses are necessary and to obtain 
any such licenses to duplicate, modify, transmit, distribute, and/or create or 
compress such media, content or tools. You agree to indemnify, defend, and hold 
harmless Licensor and each of its officers, directors, employees, subsidiaries and 
divisions, from and against losses, damages, expenses (including reasonable 
attorneys' fees), fines, or claims arising from or relating to any claim that the 
Software and Documentation was used by you in connection with the 
duplication, modification, transmission or distribution of or any other action 
relating to any content or materials in violation of another party's rights or in 
violation of any law. You may not use the Software in conjunction with any 
device or service designed to circumvent technological measures employed to 
control access to, or the rights in, a content file or other work protected by the 
copyright laws of any jurisdiction. 

14. Choice of Law; Jurisdiction; Language.

(a) This Agreement will be governed by the laws of the State of California, 
excluding: (i) the application of its conflicts of law rules; (ii) the United Nations 
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Convention on Contracts for the International Sale of Goods; (iii) the 1974 
Convention on the Limitation Period in the International Sale of Goods (the 
"1974 Convention"); and (iv) the Protocol amending the 1974 Convention, done 
at Vienna April 11, 1980.

(b) You and Licensor agree that the exclusive venue shall be the federal and state 
courts in Orange County, California, United States of America, and each of us 
submits to the exclusive jurisdiction of such courts. Nothing contained in this 
paragraph shall prevent either you or Licensor from seeking equitable relief such 
as an injunction in whatever jurisdiction as may be appropriate.

15. General

(a) This Agreement supersedes all prior agreements and understandings between 
the parties related to the subject matter herein and is intended by the parties to be 
the complete and exclusive statement of the terms of their Agreement. This 
Agreement shall not be amended, altered or changed by any purchase order or 
other instrument submitted by you. If Licensor provides any modification, 
enhancement, replacement or update for the Software to you, such modification, 
enhancement, replacement, or update shall be governed by the terms of this 
Agreement, or any additional or different terms and conditions that may be 
required by Licensor as a condition to your using such modification, 
enhancement, replacement or update. If any provision of this Agreement is held 
to be unenforceable for any reason, such provision shall be reformed only to the 
extent necessary to make it enforceable, and shall not affect the enforceability of 
any other provision of this Agreement. The waiver of any party of a breach or 
default under any provision under this Agreement or the failure of such party to 
exercise its rights under this Agreement in any instance shall not operate or be 
construed as a continuing waiver or a waiver of any subsequent breach or default. 
No waiver of any of the provisions of this Agreement shall be deemed or shall 
constitute a waiver of any other provision hereof (whether or not similar).

(b) You shall be responsible for and shall pay, and shall reimburse Licensor on 
request if Licensor is required to pay, any sales, use, value added (VAT), 
consumption or other tax (excluding any tax that is based on Licensor's net 
income), assessment, duty, tariff, or other fee or charge of any kind or nature that 
is levied or imposed by any governmental authority on the System.

(c) Except as expressly provided otherwise herein, the remedies contained herein 
are cumulative and in addition to any other remedies at law or equity. Licensor's 
failure to enforce, or waiver of a breach of, any provision hereof shall not 
constitute a waiver of any other breach of such provision. You acknowledge that 
a breach by you of Sections 2, 4, or 5 of this Agreement would constitute 
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irreparable harm to Licensor for which a remedy at law would be inadequate and 
therefore consent to being enjoined from any such breach without requiring 
Licensor to post a bond.

(d) Licensor shall not be considered in default in performance of its obligations 
hereunder if performance of such obligations is prevented or delayed by acts of 
God or government, war, riots, acts of civil disorder, labor disputes, failure or 
delay of transportation or telecommunications, or by vendors or subcontractors, 
or any other similar cause or causes beyond its reasonable control.

(e) The terms and conditions of this Agreement will be held as confidential by 
both parties hereto, provided, however, that Licensor may cite that you are a user 
of the System.

(f) The System is not fault-tolerant and is not designed, certified, tested, 
manufactured or intended for use in hazardous environments requiring fail-safe 
or uninterrupted performance, including without limitation, in the operation of 
nuclear facilities, aircraft navigation or communication systems, air traffic 
control, direct life support machines, weapons systems, or disposal of hazardous 
waste, in which the failure of the System could lead directly or indirectly to 
death, personal injury, or severe physical or environmental damage ("High Risk 
Activities"). LICENSOR AND ITS RESELLERS, DISTRIBUTORS AND 
LICENSORS HAVE NOT MADE ANY EXPRESS WARRANTIES AND 
SPECIFICALLY DISCLAIM ALL IMPLIED WARRANTIES, INCLUDING 
WITHOUT LIMITATION, WARRANTIES OF FITNESS FOR HIGH RISK 
ACTIVITIES. You agree to indemnify and hereby hold Licensor, its licensors 
and resellers harmless from any claims for losses, costs, damages, expenses, or 
liability which may arise out of or in connection with the use of the System for 
High Risk Activities.
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1
System Requirements

This chapter covers the following topic:

• Overview
• Processing System Requirements
• Testing System Requirements

Overview
You need multiple Windows® PCs to process and test streaming applications. At least one 
PC is required for processing the application and one or more PCs for testing the streamed 
version of the application. 

Processing System Requirements
This section describes the software and hardware requirements of the system on which 
application processing is performed.

Software Requirements
• Operating System - one of the following:

• Windows® XP (32-bit only)
• Windows® Vista (32-bit only)
Although Stream Weaver requires Windows® XP or Windows® Vista to run, 
applications may be targeted at other Windows® operating systems such as 
Windows® 2000. In particular, Stream Weaver provides the option of running the 
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target application installer in compatibility mode. Compatibility mode may be 
required for processing applications that are targeted at older operating systems.
Supported target operating systems are Windows® 2000, Windows® XP, and 
Windows® Vista. Please note that although Windows® 9x/Me and Windows® NT 
are not directly supported as target operating systems, applications designed for those 
platforms may run on supported target platforms in compatibility mode.

The installation of Stream Weaver and the Windows® operating system should be 
a clean install. A clean install is NOT the configuration in which most new PCs 
arrive. Typically, a PC arrives with many extra programs installed that may conflict 
with Stream Weaver.

• Processing Software: Stream Weaver 3.4 or later.
• Privilege Level: administrator

In order to run properly, Stream Weaver must be installed and launched with 
administrator privileges.

Hardware Requirements
• CPU: 1.5 GHz or higher)
• RAM: 512 MB or greater
• Disk Space: 40 GB or greater (estimated), depending on the installation size of the 

application to be processed

Testing System Requirements
One application may require testing on multiple systems. Most applications will map into 
one or more of the following testing scenarios:

Application OS Target System OS Compatibility Mode
Windows® Vista Windows® Vista No
Pre-Windows® Vista Windows® Vista No
Pre-Windows® Vista Windows® Vista Yes
Windows® XP Windows® XP No
Pre-Windows® XP Windows® XP No
Pre-Windows® XP Windows® XP Yes
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Going through several of the above testing scenarios may require processing the 
application multiple times since there may be a different installation for each operating 
system. In this case, a clean version of the Processing PC needs to be made and a new 
stream file created for each different installation.

The Test PC can be one machine or multiple machines. Multiple PC’s would allow testing 
to occur in parallel. The only requirement for the Test PC is that a clean installation of the 
operating system be present.

Additionally, the Processing PC must not be used for stream testing. This is mainly 
because at the end of the installation, the application resides entirely on the Processing PC. 
So if the streamed version of the application is tested on that PC and a component is 
missing from the stream file, the Stream Theory® Player is likely to find the installed 
component instead, which would give the appearance that the application is working fine.

The remainder of this section describes the software and hardware requirements of the 
system on which processed applications are tested.

Software Requirements 
• Operating System:

The requirements for the Test PC depends on the target operating system for the 
processed application. If the application is compatible with multiple operating 
systems, then the application will need to be tested on a PC with each of the supported 
operating systems or in compatibility mode under Windows® XP or Windows® 
Vista.

• Streaming Software: Stream Theory® Player 6.3 or later.
Please refer to the Stream Theory Player Users Guide for additional requirements.

• Support Software: As required by the streamed application.
Depending on the application, specific video card drivers (e.g. DirectX) may be 
required. See the website of the streamed application’s manufacturer for current 
updates.

Windows® 2000 Windows® 2000 No
Pre-Windows® 2000 Windows® 2000 No

Application OS Target System OS Compatibility Mode
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Hardware Requirements
• As required by the streamed application and the Stream Theory Player (both sets of 

requirements must be satisfied).
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2
Using Stream Weaver

This chapter covers the following topic:

• Getting Started
• Initial Preparation Steps
• Processing Steps

Getting Started
The transformation of an application from being installer based requiring an install and 
reboot to a streamed application requiring only a selection of an HTML link requires a 
number of processing steps. These steps are described below.

Initial Preparation Steps
Processing PC Configuration

To process an application for streaming, a clean PC is needed. A clean PC contains only 
the Windows® XP or Windows® Vista operating system and is free of any other 
unnecessary applications. This differs from a basic PC you might purchase from the store 
or have around the office. These machines may have extra applications, browsers, etc., 
that require removal. Just removing the extraneous applications might not be enough since 
“uninstalling” the applications may leave behind pieces. Though unlikely, not removing 
these applications could cause conflicts during processing, cause extra data to be included 
in the project, or for the application not to run properly. 
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Step 1: To properly configure the Processing PC, format the disk drive and install the 
Windows® XP or Windows® Vista operating system. Make sure that you have the 
manufacture’s Recovery Disk or Original Driver Disk when doing this step. 

Step 2: Install any needed drivers. Driver discs for various system components such as the 
network card, video drivers, etc. should come with the PC; however, you may have to go 
on-line to get the drivers.

Step 3: Find any driver updates from the PC manufacture or hardware card manufactures 
and install the latest version of the driver.

This will form your base system that, when imaged, can be used for processing other 
applications. Therefore, we recommend that you save an image of this configuration. 
Imaging is making a digital copy of the entire PC configuration to a separate disk or disk 
partitions for later reconfiguration of the same or another PC.

One utility that works well for this task is Norton GhostTM. 

Step 1: Install Stream Weaver
The Stream Weaver installer is supplied by either CD or email. There are two versions of 
the installer, one for the English language version and the other for the Japanese version. 

Run the installer “StreamWeaver_*.*_Eng_Setup.exe” for the English version or 
“StreamWeaver_*.*_JPN_Setup.exe” for the Japanese version. 



Chapter 2 • Using Stream Weaver Initial Preparation Steps

Stream Weaver Users Guide 23

Figure 2-1: Installer Setup Dialog

First, agree to the licensing agreement or cancel the installation.
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Figure 2-2: License Agreement Dialog

Next, choose the directory in which you want to install Stream Weaver. The default 
location is “C:\Program Files\Stream Theory\Stream Weaver”.
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Figure 2-3: Installation Directory Dialog

Then, choose the “Start Menu Folder” in which you would like Stream Weaver to be 
accessible. The default folder is “C:\Program Files\Stream Theory\Stream Weaver”. Enter 
your choice of folders of select “Install” to proceed. 
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Figure 2-4: Menu Folder Selection Dialog

The dialog as shown in Figure 2-5 is displayed upon successful installation.
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Figure 2-5: Installation Completion Dialog

The last step of installation is to put the license file (License.swl) into the “lib” directory 
under the installation directory.  For example:

 “C:\Program Files\Stream Theory\Stream Weaver\lib\license.swl”.

Stream Theory® supplies the license file (License.swl). This file will either be mailed to 
the licensee or will be supplied on a removable media such as a CD. 

Keep a copy of license file in case Stream Weaver is uninstalled and the license deleted.

Step 2: Imaging the Processing PC
Next, create an image of the above PC configuration. (Imaging is explained in the 
beginning of this section.)
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If a newer version of Stream Weaver is required, then a new image needs to be made 
to incorporate the new version of Stream Weaver. Remember, you should already 
have made an image of the original base configuration without Stream Weaver. In 
order to make an image with a new version of Stream Weaver, simply re-image the 
system using the base configuration and install the new version of Stream Weaver. 
After installation, image this new configuration for use in future application processing.

Step 3: Test PC Configuration
For testing, a separate PC should be available, cleanly configured, loaded with the Stream 
Theory Player, the required support programs, latest device drivers, and loaded with the 
requisite operating system. The same steps should be followed in configuring the PC as 
was followed in creating the Processing PC in “Processing PC Configuration” on page 21, 
except that Stream Weaver is not installed. Instead, install the Stream Theory Player on 
the Test machine.

Depending on the number of operating systems being tested, more than one Test PC 
may be required. Alternatively, you can have one test machine with multiple images of 
various operating systems.

Step 4: Test PC Imaging
Next, create an image of the above PC configuration. Norton GhostTM is one utility that 
will accomplish this task. 

If a newer version of the Stream Theory® Player is required, then a new image of each 
configuration is required.

Processing Steps
If an image, as specified in “Step 2: Imaging the Processing PC” on page 27, of a 
Processing PC configuration is not available, go to this section and create an image for 
processing.
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Step 1: Re-image the Processing PC
Load the image of the clean operating system with Stream Weaver on the PC with which 
the application is to be processed, then start Windows®.

If you have already processed an application and choose to process another 
application without re-imaging the processing machine, you should at least reboot the 
machine. Not doing so, may prevent Stream Weaver for capturing installation changes 
for the second processing session.

Step 2: Start Stream Weaver
Either select Stream Weaver from the start menu or double click the Stream Weaver icon 
on the desktop. The dialog shown in figure 6 should be displayed. If work on a previously 
saved file is to be continued, then close the “Untitled1” project window and use the File 
pull down to open the desired project. 
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Figure 2-6: Stream Weaver Project Window

Step 3: Capture Installer Settings
The next step is to capture the installer settings. This includes the capture of all the 
application files and their associated directory locations, directory creation, the registry 
values, and environment variables. To capture these settings, the installer is run and 
Stream Weaver monitors what and where files are loaded and what and where registry 
values set during the application installation. 

Note the following points for the capture installer settings stage of processing:

• The information in the project window does not have to be filled out at first. 
• Even though the program may require a specific version of DirectX, Acrobat, or 

QuickTime; these programs/plug-ins are not needed for the processing system. They 
will need to be installed into the testing system. One exception to this requirement is 
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if the application that is actually installed on the streaming machine needs to be 
tested. If problems running the streamed application occur, one step is to verify that 
the installed application properly works on the processing machine. In this case, this 
would require that any support applications like, Adobe Reader, Internet Explorer, 
QuickTime, be loaded and any required driver updates, DirectX for example) be 
updated on the processing machine.

As shown in Figure 2-7, from the file menu, select “Merge Installer Run”. 

Figure 2-7: Project Setting’s Menu

This will bring up the dialog box shown below in Figure 2-8.
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Figure 2-8: Merge Installer Run Dialog

Merger Installer Run Dialog Box
Compatibility Settings (Windows® XP and Windows® Vista only) – This button 
brings up a dialog that allows adjusting several compatibility options to be used when 
launching the installer. For instance, this may be needed for installers designed for an 
operating system older than the Processing PC operating system. Which options are 
accessible depends on the Processing PC operating system. For instance, under 
Windows® XP, new compatibility settings introduced in Windows® Vista will be 
disabled.

For information on the available compatibility options, please refer to “Compatibility 
Settings Dialog” on page 43.

Installer process and sub-processes only - When this option is selected, the install 
monitor to record only file and registry activity coming from the installer processes and its 
sub-processes. 

All processes - When this option is selected, the install monitor to record file and registry 
activity coming from all processes. 



Chapter 2 • Using Stream Weaver Processing Steps

Stream Weaver Users Guide 33

It is not recommended to have other programs installed and/or active while processing 
an application. However, Microsoft has parts of its installer run as a “Service” under 
Windows® and sometimes all of the installation activities are not captured. This is 
because the “Service” activities are not a sub-process of the installer process. 
Therefore, to capture all the install activities, the process level filtering needs to be 
turned off so that all process level activities are captured. However, first one should try 
running the installer without disabling the filter in that it may work. Disabling the filter 
runs the risk of capturing unneeded information and causing the Stream and Token 
file to be larger than required.

Type in the path for the Installer file. To browse for the Installer path, use the “…” button 
on the right of the “Installer Path:” field. For our example, the application “Acrobat 
Reader™” by Adobe is processed into a streaming format. The installer for this 
application was previously downloaded and the running of the “Acrobat Reader” installer 
from Stream Weaver looks like what is shown below in Figure 2-9.

Figure 2-9: Setting Install Path

Start the installer by selecting the “Launch” button. During capture, the installer runs and 
installs the application. Stream Weaver watches the installer and monitors and creates a 
record of all installed files and registry keys created.

! CAUTION
If the installer directory is not carefully selected in reference to the application, it is possible that the 
installer filter will remove application related files. Therefore, the following restrictions should be 
followed for choosing the installer directory. IMPORTANT! Care must be taken in the selection of the 
directory in which the application is installed and the directory from which the installer is run. The 
application should not be installed in a directory under where the installer is found and additionally the 
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installer should not be located at the root directory. This is because there is an implicit filter for the files 
associated with the installer directory. Installers will often create temp files as part of the installation 
process. These files would be captured as part of the application installation process but actually are 
not part of the installed application. Therefore, an implied installer filter is built into Stream Weaver. To 
prevent the capture of the temp installer files, all files in the directory below the installer directory are 
filtered out by Stream Weaver. 

Installer Directory Restrictions
• The installed application should not be in the same directory as the installer 

executable or in a subdirectory of the installer directory. 
• The installer should not be the directory “C:\”. This will cause a null filter to be 

created. If Stream Weaver detects a null filter, instead of filtering everything, it filters 
nothing. Though technically this won’t prevent proper application streaming, the 
token and stream files will contain unneeded data and be larger than required.

• The application has to be installed to a C: drive.
• Do not use special characters in the installation directory name. No umlauts, ~, !, @, 

#, à. Á …
Once Stream Weaver launches the application installer, all the normal application specific 
installation dialogs are displayed. For “Acrobat Reader”, the Installer dialog as shown in 
Figure 2-10 appears.  
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Figure 2-10: Acrobat Installer Dialog

For the “Acrobat Reader” installer, a series of installation windows are provided ending 
with the window shown in Figure 11. 

Select the finish button to complete and end the installer for “Acrobat Reader”.
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Figure 2-11: Final Acrobat Installer Menu

Stream Weaver can not determine when an application Installer has completed, so the 
dialog window as shown in Figure 2-12 is displayed once the Installer starts. By selection 
“OK” you are telling Stream Weaver that the application installation is complete. “OK” 
should not be selected if there are patches to be added to the application. See Appendix A: 
Program Patches. 

Select the “OK” button shown in Figure 2-12. This completes the process of capturing the 
installer settings. In the following steps, the information gathered during installation will 
be used to create the Stream and Token files.
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Figure 2-12: Status window for Installer Processing

Viewing Captured Information
It is possible to browse through the files or the registry settings. To view the files select 
Files from the View menu, or press the key sequence <Ctrl>F. The Files view is shown 
below.

Figure 2-13: Files View

To view the registry settings, select Registry from the View menu or press the key 
sequence <Ctrl>R. The Registry view is shown below.
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Figure 2-14: Registry View

To view the environment variables, select Environment from the View menu or press the 
key sequence <Ctrl>E. The Environment view is shown below.
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Figure 2-15: Environment View

Note that the information shown it the Files, Registry and Environment views can be 
augmented, removed or changed if necessary (see “Editing Captured Information” on 
page 58). This information is stored in the *.stw file and initially represents what was 
installed. Changes to the files, registry values or environment variables using Stream 
Weaver are not reflected in the actual system directory. These values are incorporated into 
the token file and are used by the Player’s registry overlay.

Step 4: Fill-Out App Info
Before creating the Stream file and Token file, application information must be filled out. 
To fill out this information, open the “Project Settings” window by going to the “View” 
pull down menu and selecting “Project Settings” or selecting <Ctrl>P. For our sample 
application, “Acrobat Reader”, the figure below shows what the project dialog would look 
like after filling in the dialog. If returning to Stream Weaver after closing the application, 
the project can be reopened by selecting the menu pull-down “File” and selecting “Open”. 
This will bring up a dialog for browsing and selecting the stream file for which you were 
searching.
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Figure 2-16: Figure 15: Project Dialog Window

Application Info Pane
In the Application Information Pane, you can see general information about a title. This 
information is stored within the *.stw file and is typically used to track processed titles. 
Additionally, Stream Weaver uses some of the information in generating the Stream and 
Token files. The short name is used in naming the Token and Stream files and the Long 
name determines the title name the end user sees on the Stream Theory® Player. Also this 
information is used in creating an application install file for the server. Most of this 
information comes from the application publisher but there is a field for the processing 
organization to add their own comments for their own information about the application. 
This information can also be pulled into a database to manage the processed applications.
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• Publisher – Is the name of the application publisher and is important for the tracking 
of licensed applications. Information is stored in the Stream Weaver file, 
“app_name.stw”, the server install file, and gets stored on the server. It is often used 
in the tracking of application usage to determine royalty payments.

• Short Name – This will be the name used for the creation of the token, stream, and 
install file.

• Long Name – This name is the name displayed in the Stream Theory® Player history 
window after the game being selected

• ESRB – (Entertainment Software Rating Board) This selection field is the 
application’s rating. For games, the publisher will provide this information.  For 
business applications, this field can be set to none. This information is stored in the 
server installation file.

• System Requirements Description – These are the requirements provided by the 
application publisher and is usually just copied off the box. 

• Program Description – This is a field to describe the program. It is stored in the 
Stream Weaver file, *.stw, and also stored in the install file that is uploaded to the 
server. This information is mainly used for informational purposes.

Application Launch Pane
The Application Launch fields define the command line that starts the application and the 
working directory from which the application locates the rest of the files.

• Command Line – Specifies the command line used to start the program. The easiest 
way to populate it properly is to navigate in the Files view to the application’s 
executable that is to be launched, right-click on it, then choose Copy to Command 
Line. If you’re not sure where the executable is located, one way it can be found is by 
looking at the properties of the shortcut created when the application was installed.
If you want to launch a non .exe file such as a .doc file, for instance, please refer to 
“Processing Non Application Files” on page 75.

• Working Dir – Specifies the folder that contains the application’s executable or some 
related files. A vast majority of the time, using the same directory as used in the 
command line will work. On occasion using the same directory as where the program 
executable is found will not work. In these cases, it may be required to set the 
Working Directory to the application root directory. The easiest way to populate this 
field is to navigate in the Files view to the folder that you want to set as the working 
folder, right-click on it, then choose Set As Working Folder.
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Operating System Support Pane
Operating System Support Pane specifies the Operating Systems for which the application 
is compatible. This information is stored in the token file so that when a token file is 
accessed, the Stream Theory® Player can determine if the application is compatible with 
user’s Operating System. Location of Operating System compatibility information is 
usually found in the product information for the application, or on the application box, on 
the publisher’s web site or through testing. 

For each Operating System, the streamed application should be tested on the target 
Operating System. 

If the processed application is run on a machine for an unsupported Operating System, the 
Stream Theory® Player will display a dialog indicating that the Operating System is not 
supported and will not start the application. Sometimes testing indicates that an 
application is compatible with an Operating System where the product literature does not 
specify that particular Operating System. This often happens with applications created 
before the Windows® XP release. To test a standalone stream file on XP, the Windows® 
XP check box must be selected. For the version that is streamed from the Server, one 
should not check the Windows® XP option. The Token server has the capability to 
override the Operating System settings. When done this way, the ST Player will display a 
dialog warning the user. The dialog provides a warning that testing indicates that the 
application works with Windows® XP though the vendor information does not specify 
Windows® XP compatibility

• Windows® 95 – Windows® XP – Check the boxes for the Operating Systems that are 
supported by the applications.

• Compatibility Settings (Windows® XP and Windows® Vista only) – This button 
brings up a dialog that allows adjusting several compatibility options to be used when 
launching the processed application. For instance, this may be needed for applications 
designed for an operating system older than the target operating system(s). Which 
options are accessible depends on the selected target operating systems. For instance, 
if only Windows® XP is selected, then new compatibility settings introduced in 
Windows® Vista will be disabled.
For information on the available compatibility options, please refer to 
“Compatibility Settings Dialog” on page 43.
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The “Compatibility Settings” button is enabled only if Windows® XP and/or Windows® 
Vista is selected as a target operating system as compatibility settings are not 
supported by the Windows® 2000 operating system.

Compatibility Settings Dialog
The Compatibility Settings dialog offers several options that affect the environment in 
which a program is launched. In the context of Stream Weaver, the program may be either 
a processed application installer (see) or the processed application itself, upon streaming 
(see). Those options are useful for programs designed to run on older operating systems 
than the ones on which they will actually be run. If some of those options are set for a 
given program, then Windows® automatically modifies the run-time environment upon 
launching the program to make it as close as possible to the environment required for the 
program to function properly.
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Run this program in compatibility mode – This setting is used when a program is only 
compatible with an operating system older than the one on which it will run. For instance, 
since Stream Weaver only runs on Windows® XP or Windows® Vista, this option should 
be checked for processing all Windows® 9x-only applications.  If the application indicates 
compatibility with Windows® 9x and Windows® XP, then this option does not need to be 
selected. As a rule of thumb, the most recent supported operating system should be 
selected for compatibility mode.

Run in 256 colors – This setting forces the entire screen to 256 colors while the program 
is running. This may be necessary for older programs, especially games, that do not 
support 16-bit colors and higher.

Run in 640x480 screen resolution – This setting forces the entire screen to 640x480 
resolution while the program is running. This may be necessary for older programs, 
especially games, that do not support higher resolutions. Try this setting if the graphical 
user interface appears jagged or is rendered improperly.

Disable visual themes – This setting turns off all visual themes while the program is 
running. Try this setting if you notice problems with the menus or buttons on the title bar 
of the program.

Turn off advanced text services for this program (Windows® XP only) – This setting 
disables advanced text services such as speech recognition.

Disable desktop composition (Windows® Vista only) – This setting turns off 
transparency and other advanced display features. Choose this setting if window 
movement appears erratic or you notice other display problems.

Disable display scaling on high DPI settings (Windows® Vista only) – This setting 
turns off automatic resizing of programs if large-scale font size is in use. Try this setting if 
large-scale fonts are interfering with the appearance of the program.

Run this program as an administrator (Windows® Vista only) – This setting causes 
Windows® to elevate the program to administrator level before running it. Some 
programs require administrator privileges to run properly.

For more information on a particular setting, search one of the following web sites:

• http://support.microsoft.com/
• http://windowshelp.microsoft.com/
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Required System Components Pane
Required Components to Run (DirectX, QuickTime, Acrobat) - For some 
applications, additional system components are required for the applications to either run 
or run completely. The Player will check the local machine for the specified components. 
The Player will not prevent the application from running but if a component is not 
installed, the Player will put up a warning dialog before starting the application. 

The components referenced in this section are not streamed but are installed on the 
end client’s PC.

The component information is stored in the token file and is checked at application stream 
time against the client PC configuration.

The “Minimum Cache Size” field refers to the cache used by the Player. All stream blocks 
read by the Player are stored in the cache and if the cache is too small a phenomena called 
disk thrashing occurs. For every new block read, a block is flushed from the cache and 
shortly again has to be read from the network. This can greatly slow the application’s 
performance.

The solution for this problem is to make the cache large enough to prevent cache 
thrashing. However, typically no specification of cache size is required given that the 
default Player installation is for 512 Mbytes of cache. This is more than adequate for 99% 
of the applications. For exceeding large applications, one may want to set this field. If this 
field is set and the current cache is not large enough, then the application will not run and 
will present an error dialog.

Step 5: Stream File Creation
The next step is to create the initial Token and Stream files. The process of generating 
Stream files will be repeated multiple times. The first generation of the Stream files does 
not contain jumpstart information. In the next regeneration of the Stream Files, the *.stw 
file will contain jumpstart information. Upon doing the secondary jumpstart, the third 
generation of the Stream files will contain the secondary jumpstart information. Further 
regeneration of the Stream files may be required to fine tune the jumpstarts.

Creation of these files only requires a couple of simple steps. First select the “File” pull 
down menu, and selecting as shown below “Create Token/STC Files…” or pressing 
<CTRL>T as shown in Figure 2-17.
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Figure 2-17: Token & Stream File Creation

The dialog shown below should appear. Within this dialog, you can specify the file name 
and directory. The file name will be used to create the “file_name.tok” file or the 
“file_name.stc” file. 

Press “OK” to generate the stream files (*.stc) and token files (*.tok).
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Figure 2-18: Stream File Generation Dialog

The number after the title name is a UUID code and is used to create uniquely 
identified files for each build. 

The dialog below in Figure 2-19 should appear. The progress bar will show the status of 
the processing. For a program of the size of Adobe’s Acrobat Reader, this should only 
require 2-3 minutes. 

Multiple CD applications with large amounts of data may require a few hours to 
process.
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Figure 2-19: Stream File Processing Status Dialog

Upon successful processing of the applications description, as defined by the 
“Reader.stw” files, three files are created and stored into the specified directory. Below, in 
Figure 2-20, is a screen shot of this directory.  

Figure 2-20: Stream File Processing Status Dialog

The files created by stream processing are:

• “app_name”_”uuid”.stc - This is the file that will be put on the Stream Server. The 
long number appended to the end of the application name is what is referred to as a 
UUID (Universal Unique Identifier). The UUID is used to guarantee the unique 
naming of the stream files. 

• “app_name”_”uuid”.tok -This file is the initial version of the token file. The file could 
be put on the Token Server, but would be missing the jumpstart information. 

• “app_name”_”uuid”.txt - This text file is used to install the application onto the 
server.
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If using Stream Weaver, changes are made to the configuration and the application 
reprocessed, a new set of files will be created giving a new UUID. If you change the name 
of the token file, you will have to change the name of the STC file as well.

Step 6: Test Streamed Application
Now that the application is in a streaming format, it can and should be tested. Testing of a 
streamed application does not require installation the Stream Flow Servers but can be 
tested stand-alone on the Test PC. To test our example application, Acrobat Reader, copy 
the build files (Reader_*.tok and Reader_*.stc) to a clean and re-imaged test machine with 
an appropriate Operating System. See section of “A. Initial Preparation Steps” for 
requirements on imaging the PC’s.

Double click on the Reader_*.tok file. This will start the Stream Theory® Player and the 
Acrobat Reader program. Test the program and verify that it works properly.

Step 7: Primary Jumpstart 
Jumpstarting an application is optional, so if you don’t wish to use that feature then you 
are done processing the application and you can skip the remainder of this chapter.

Once it has been verified that the streamed application’s executes properly on the Test 
PC’s , the streamed application can be jumpstarted.

The Primary and Secondary jumpstarting and stream file testing should always be 
done on the Test PC and not on the Processing PC. 

Jumpstarting is the process of specifying which stream blocks of the application need to 
be in the Player cache before the application starts to run. The amount of the application 
that is jumpstarted, i.e. pre-cached, is a trade-off between the first-run start time and later 
delays as blocks are loaded on demand. The background secondary jumpstart will be 
described later. 

The second time the application is run, unless flushed from the cache, the application 
start-up times will be much faster given that the application is loaded from the disk 
cache. 
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1. The first step in jumpstarting an application is creating a Stream Theory® Player 
shortcut on the Test PC with a special command line for capturing jumpstarting 
information. To create this shortcut, go to the Player install location and created a 
shortcut to the Player. For our example, Let’s assume that the Player is in the directory 
“C:\Program Files\Stream Theory®”. To create the Player shortcut, right click on the 
file “C:\Program Files\Stream Theory\STPlayer.exe” and select “Create Shortcut”.  
Your directory should look as Figure 20 shown below. 

Figure 2-21: Player Short Cut

2. Select the short cut and right click on the mouse. Select properties. The dialog shown 
in Figure 2-22 should appear. The “Target” field needs to be modified for 
jumpstarting.
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Figure 2-22: Player Shortcut Properties Dialog

Next add to the string in the “Target” field, the following 

 “/captureJumpstartdata /IgnoreJumpstart”

The full string should appear exactly as shown below including the quote marks:

 “C:\Program Files\Stream Theory\STPlayer” /captureJumpstartdata /IgnoreJumpstart 

The dialog below shows the dialog after modification.
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Figure 2-23: Player Shortcut Properties Dialog

Select the “Apply” button after modifying the “Target” field followed by selecting the OK 
button.

3. Care now has to be taken to start the Player with the modified short cut. Otherwise, 
the jumpstart information will not be created. To assure this, now double click on the 
modified shortcut icon and start the Stream Theory® Player. 



Chapter 2 • Using Stream Weaver Processing Steps

Stream Weaver Users Guide 53

4. Copy the Stream and Token files from the processing PC to the Test PC. Now double 
click on the token file for the processed application. Each stream block that is loaded 
into the cache is recorded and saved into a jumpstart file named 
‘“app_name”_”uuid”.stj’. For the example application, this would be the file 
‘Reader_”uuid”.stj’. Go through as much of the application as you feel that the user 
should have before the application starts. For games, this is usually the first level of 
play. The secondary jumpstart, as will be discussed later, might be the second level of 
play. Once you have done with the first level (Or first jumpstart point), exit the 
application.

5. Exit the Player.
6. Copy the Reader_*.stj file over to the processing machine. This file is found in the 

processing directory that was specified. In this example, the file is found at “c:\Stream 
Files\Processed_Acrobat\Reader_*.stj”. 

Step 8: Merge Primary Jumpstart Data
Merging Jumpstart data is the process of taking the jumpstart information that was 
captured in the Reader*.stj file and putting it into the Reader_*.stw Stream Weaver file. 
The next time that Stream Weaver is used to generate a Token and Stream file, the 
jumpstart information will be included in the Token file.

To merge the jumpstart data, make sure that the *.stj file is copied into the same directory 
as is the corresponding *.stw file. 

1. Start the Stream Weaver application or by double clicking on the *.stw file.
2. Open the Stream Weaver file for the application being processed. In this case, it is 

“Reader_***.stw”. Make sure that the window for this application is the active 
window.

3. As the dialog shows in Figure Pull down the “File” menu item and select “Merge 
Jumpstart Data… Ctrl+J.” or select <CTRL>J from the keyboard. 
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Figure 2-24: Player Shortcut Properties Dialog

This will bring up the “Merge Jumpstart Data …” dialog as shown in Figure 2-25. Enter 
the path for the jumpstart file, *.stj. Note that an “App ID” is assigned for each application 
and for each build of the application. Stream Weaver will check the application ID of the 
*.stw file against the *.stj file. If they don’t match, Stream Weaver won’t merge the 
jumpstart information to prevent using incorrect jumpstart information.
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Figure 2-25: Jumpstart Dialog

4. Select the first option “Merge collected jumpstart data into Primary Jumpstart” and 
press “OK”. It should be less that a couple of seconds for the primary jumpstart data 
to be merged into the file. 

If there is already primary jumpstart data in the Stream Weaver *.stw file, then the 
merge will only add stream blocks that are not already in the *.stw file. If the goal is to 
completely replace the current primary jumpstart with the new jumpstart, then instead 
of selecting the first option, “Merge collected jumpstart data into Primary Jumpstart”, 
select the third option “Replace existing Primary Jumpstart with collected jumpstart 
data”.

Removing Jumpstart Information
Should you need to remove jumpstart information for any reason, do the following:

• From the Edit menu, choose Clear Captured Jumpstart Data.

This will remove both the primary and secondary jumpstart information.



Chapter 2 • Using Stream Weaver Processing Steps

56 Stream Weaver Users Guide

At this point you have the option to either add a secondary jumpstart as described in the 
next step or rebuild the stream files as described in “Step 10: Rebuild Stream Files” on 
page 58 to incorporate jumpstart information.

Step 9: Secondary Jumpstart
The secondary jumpstart is an optional step that specifies which stream blocks of the 
application are streamed to the Player cache after the primary jumpstart and typically after 
the application has started. An example of a secondary jumpstart might be the loading the 
second level of a game or various application options for a business application. 

The use of a secondary jumpstart is best suited for games and applications that are 
complex or offer a high level of functionality. Small or basic programs such as Winzip 
or Winamp are not large enough to create much difference in secondary jumpstart 
information.

If you don’t wish to add a secondary jumpstart, you can go to the next step to rebuild the 
stream files if you have added a primary jumpstart. Otherwise you are done processing the 
application and you can skip the remainder of this chapter.

The secondary jumpstart typically occurs at a slower rate than the primary jumpstart. This 
is so that the data requested during the secondary jumpstart does not interfere with data/
executable requests that might be required by the application during its normal execution.

1. Repeat the steps in “Step 7: Primary Jumpstart ” on page 49, steps 3-7 except run the 
application further than when you ran it for the primary jumpstart. 

2. With the new *.stj file transferred to the processing machine, the “Secondary 
Jumpstart” information can now be merged into the Stream Weaver file. 

Even though the *.stj file contains information about stream blocks found in the 
primary jump, Stream Weaver will only put blocks that do not exist in the primary 
jumpstart into the secondary jumpstart.

3. From the Stream Weaver application, open the application being processed.
4. Start the Stream Weaver application or double click on the Stream Weaver file, *.stw.
5. Open the Stream Weaver file for the application being processed. In this case, it is 

“Reader_***.stw”. Make sure that the window for this application is the active 
window.
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6. Pull down the “File” menu item and select “Merge Jumpstart Data… Ctrl+J.” or 
select <CTRL>J from the keyboard. This will bring up the “Merge Jumpstart Data 
…” dialog shown below. Enter in the path for the jumpstart file, *.stj, that was created 
during the secondary jumpstart. Note that an “App ID” is assigned for each 
application and for each build of the application. Stream Weaver will check the 
application ID of the *.stw file against the *.stj file. If they don’t match, Stream 
Weaver won’t merge the jumpstart information and prevent using the incorrect 
jumpstart information.

Figure 2-26: Merge Jumpstart Data Dialog

7. Select the second option “Merge collected jumpstart data into Secondary Jumpstart” 
and press “OK”. It should be less that a couple of seconds for the secondary jumpstart 
data to be merged into the file. 
If the goal is to completely replace the current secondary jumpstart with the new 
jumpstart, then instead of selecting the second option, “Merge collected jumpstart 
data into Secondary Jumpstart”, select the fourth option “Replace existing Secondary 
Jumpstart with collected jumpstart data”.
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If necessary, you can remove jumpstart data as described in “Removing Jumpstart 
Information” on page 55

At this point you should rebuild the stream files as described in the next step.

Step 10: Rebuild Stream Files
The last step is to rebuild the stream (*.stc) and token (*.tok) files to incorporate jumpstart 
information. If you have not created any jumpstart information, then you are done 
processing the application and you can skip this step.

To rebuild the stream files, simply go to the File menu and select the “Create Token/STC 
File” option as you did before. The new token and stc files should be retested on a clean 
Test PC to verify that the jumpstart information is now included and to verify proper 
operation. If the jumpstart performance of these files are acceptable, then all three files, 
the *.stc, *.tok, and *.txt files are complete and ready to be uploaded to the server. See the 
“StreamFlow Server Architecture, Installation, and Administration Manual for further 
details about installing applications. If further refinements to jumpstarting is required, 
then repeat steps 7, 8, 9 & 10.

Editing Captured Information
Some times it may be necessary to make modifications to the captured information either 
to add some things that were not captured or to remove “noise” that was introduced as a 
side effect of the application installation. This section describes some of the common 
operations you may need to perform.

Files View Operations
The Files view is accessed by selecting Files from the View menu.
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Figure 2-27: Files View

Most commands can be accessed either from the Edit menu or by right-clicking on a 
folder in the folders (left) pane or on a file in the files (right) pane.

Adding Folders
Two types of top-level folders appear in the folders pane: system folders and install 
folders. System folders are operating system-specific folders that are always present and 
cannot be manually added or removed. They are identified with a small black square at the 
bottom of the folder icon. Install folders are those created during installation or added 
manually. They are identified with a small red diamond at the bottom of the folder icon. 
Subfolders may be created under both types of folders.

To add an install folder
1. Right-click on any folder or on a blank area of the folders pane.
2. Choose Add Install Folder from the popup menu. The Add Install Folder dialog 

will appear.
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Figure 2-28: Add Install Folder Dialog

3. If you wish to create a new install folder, select Create new install folder and enter a 
path for it. If you wish to add an existing folder instead, select Create from existing 
source folder.

4. If you chose to add an existing folder, you can also select one or more of the 
following options:
• Recursively include subdirectories – Selecting this option will cause all 

subfolders under the selected folder to be added as well. Otherwise only the 
selected folder is added.

• Include files within the directory(s) – Selecting this option will add all the files in 
the folders being added. Otherwise only the folders are added.

• Use existing folder name – Normally the selected folder is added with its current 
name. If you wish to add the folder under a different name, clear this option and 
specify the new name to be given to the folder.

5. Click OK.
The Files view will be updated to reflect the added folders and files.

To add a subfolder
1. Right-click on any install or system folder.
2. Choose Add Folder from the popup menu. The Add Folder dialog will appear.
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Figure 2-29: Add Folder Dialog

3. If you wish to create a new folder, select Create new folder and enter a name for it. If 
you wish to add an existing folder instead, select Create from existing source 
folder.

4. If you chose to add an existing folder, you can also select one or more of the 
following options:
• Recursively include subdirectories – Selecting this option will cause all 

subfolders under the selected folder to be added as well. Otherwise only the 
selected folder is added.

• Include files within the directory(s) – Selecting this option will add all the files in 
the folders being added. otherwise only the folders are added.

• Use existing folder name – Normally the selected folder is added with its current 
name. If you wish to add the folder under a different name, clear this option and 
specify the new name to be given to the folder.

5. Click OK.
The Files view will be updated to reflect the added subfolders and files.

Adding Files
Stream Weaver allows you to add any files to any folder.
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To add a file to a given folder
1. Right-click on the desired folder or on a blank area of the files pane if the desired 

folder is currently selected.
2. Choose Add File from the popup menu. The Add File dialog will appear.

Figure 2-30: Add File Dialog

3. Enter the path of the file you wish to add or browse to it.
4. Normally the selected file is added with its current name. If you wish to add the file 

under a different name, clear the Use existing file name option and specify the new 
name to be given to the file.

5. Click OK.
The Files view will be updated to reflect the added file.

Changing the Source or Name of a File
If after adding a file you realize that you have added the wrong file or you decide that you 
wish to change its name, you can do so without the need to delete the file and add it again.

To change the source or name of a file
1. Right-click on the file whose source or name you wish to change.
2. Choose Edit File from the popup menu. The Edit File dialog will appear.
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Figure 2-31: Edit File Dialog

3. To change the source of the file, enter the new path of the source file or browse to it.
4. To change the name of the file, make sure the Use existing file name option is not 

checked and specify the new file name.
5. Click OK.
The Files view will be updated to reflect the changes made.

Deleting Files and Folders
It is possible to delete any file or install folder that was created during installation or that 
was added manually.

To delete a file or folder
1. Right-click on the file or folder that you wish to delete.
2. Choose Delete from the popup menu.
3. Choose OK when prompted for confirmation.

Setting the Working Folder
For information on setting the working folder, please refer to page 41.

Setting the Command Line
For information on setting the command line, please refer to page 41.
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Editing File Properties
A file has a number of security and jumpstart settings that can be modified to suit your 
specific needs.

To edit a file’s properties
1. Right-click on the file whose properties you wish to change.
2. Choose File Properties from the popup menu. The Edit File Properties dialog will 

appear.

Figure 2-32: Edit File Properties Dialog

3. The following security settings may be configured:

For .exe files, all security settings are enabled by default.

• Never load a local copy of this file
You should enable this option if you want to prevent the Stream Theory Player 
from loading a local copy of a streamed application file. Otherwise, when the 
Stream Theory Player needs to load an application file on the end user system, it 
will first attempt to load a local copy of it if one is present, otherwise it will try to 
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load it from the cache and, if it does not find the file in the cache, it will stream it 
from the server.

• Hide when enumerating directory
If this setting is enabled, the selected files will not appear as part of the file listing 
of the folder to which it belongs. In this case, for instance, the file will not appear 
in Windows Explorer or in the File Open and File Save dialog boxes, and it will not 
show up in a Windows search.

When processing applications that launch other .exe files, you may need to 
disable this setting for these .exe files, otherwise a “missing file” error may result 
when the processed application attempts to launch them.

• Prevent copying
If this setting is enabled, it will not be possible to make a copy of the file.

4. The following jumpstart settings may be configured:
• Include in primary jumpstart

This setting allows you to explicitly include the file in the primary jumpstart 
without the need to do a jumpstart capture.

• Include in secondary jumpstart
This setting allows you to explictely include the file in the secondary jumpstart 
without the need to do a jumpstart capture.

5. Click OK.
The Files view will be updated to reflect the changes made.

Registry View Operations
The Registry view is accessed by selecting Registry from the View menu.
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Figure 2-33: Registry View

Most commands can be accessed either from the Edit menu or by right-clicking on a key 
in the registry keys (left) pane or on a value in the registry values (right) pane.

Adding Registry Keys
You can create a new subkey or add an existing subkey under any key in the Registry view 
including root keys (or hives). However, you cannot create new root keys.

To add a subkey
1. Right-click on any key in the registry keys pane on the left.
2. Choose Add Key from the popup menu. The Add Registry Key dialog will appear.
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Figure 2-34: Add Registry Key Dialog

3. If you wish to create a new key, select Create new key and enter a name for it. If you 
wish to add an existing key instead, select Create from existing registry key.

4. If you chose to add an existing key, you can also select one or more of the following 
options:
• Recursively include subkeys – Selecting this option will cause all subkeys under 

the selected key to be added as well. Otherwise only the selected key is added.
• Include values within the directory(s) – Selecting this option will add all the 

values in the keys being added. Otherwise only the keys are added.
5. Click OK.
The Registry view will be updated to reflect the added subkeys and values.

Adding Registry Values
Stream Weaver allows you to add values to any folder.

To add a registry value to a given key
1. Right-click on the desired key or on a blank area of the registry values pane if the 

desired key is currently selected.
2. Choose Add Value from the popup menu. The Add Registry Value dialog will 

appear.
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Figure 2-35: Add Registry Value Dialog

3. Enter the name of the value you wish to add in the Name field.
4. Select the data type of value from the Type drop-down list.
5. If you wish to view or enter the data in hexadecimal format, check the Display as 

hexadecimal option. Otherwise, data is assumed to be in decimal format.
6. Enter the data in the Data field.
7. Click OK.
The Registry view will be updated to reflect the added value.

Editing Registry Values
You can edit registry values after they have been added.

To edit a registry value
1. Right-click on the desired value you wish to edit.
2. Choose Edit Value from the popup menu. The Edit Registry Value dialog will 

appear.
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Figure 2-36: Edit Registry Value Dialog

3. Make the necessary changes (see “Adding Registry Values” on page 67 for more 
information).

4. Click OK.
The Registry view will be updated to reflect your changes.

Deleting Registry Keys and Values
It is possible to delete any registry key or value that was created during installation or that 
was added manually.

To delete a registry key or value
1. Right-click on the registry key or value that you wish to delete.
2. Choose Delete from the popup menu.
3. Choose OK when prompted for confirmation.

Environment View Operations
The Environment view is accessed by selecting Environment from the View menu.
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Figure 2-37: Environment View

This view displays environment variables that have been created either during installation 
or manually. Most relevant commands can be accessed either from the Edit menu or by 
right-clicking on an environment variable.

Adding Environment Variables
You can create new environment variables as described below.

To add an environment variable
1. Right-click on a blank area of the Environment view.
2. Choose Add Environment Variable from the popup menu. The Add Environment 

Variable dialog will appear.
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Figure 2-38: Add Environment Variable Dialog

3. Enter a name for the new environment variable in the Name field.
4. Enter a value for the variable in the Value field.
5. Click OK.
The Environment view will be updated to reflect the added variable.

Editing Environment Variables
You can edit any environment variable that was created manually or during installation.

To edit an environment variable
1. Right-click on the environment variable that you wish to edit.
2. Choose Edit Environment Variable from the popup menu. The Edit Environment 

Variable dialog will appear.

Figure 2-39: Edit Environment Variable Dialog

3. Make the necessary changes (see “Adding Environment Variables” on page 70 for 
more information).

4. Click OK.
The Environment view will be updated to reflect your changes.
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Deleting Environment Variables
It is possible to delete any environment variable was created during installation or that was 
added manually.

To delete an environment variable
1. Right-click on the environment variable that you wish to delete.
2. Choose Delete from the popup menu.
3. Choose OK when prompted for confirmation.
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A
Applying Program Patches & Updates

Some applications require program patches and theses patches must be incorporated into 
the stream files. Capturing patch information is conducted by launching the patch 
application from within Stream Weaver and Stream Weaver will capture the additional 
installation information about which files are added, deleted, or registry settings added, or 
deleted. Existing files or applications that are modified are captured during the step of 
creating the stream and token file. This new information about files and registers modified 
is stored within the “application_name.stw” file and is utilized to create the stream and 
token files.

The original program must be installed on the Processing PC in order for a patch to be 
properly integrated. A patch cannot be placed on a Token/STC file that has been 
completed and is no longer resident on a Processing Machine.

So for our current example, say that a patch is required for the application. Follow these 
steps.

1. Start up Stream Weaver. 
2. Open the Stream Weaver file for the application for which the patch is to be applied.

! CAUTION
Important: Make sure that only one *.stw file is open. This includes the “Untitled*.stw” 
file. The patch installer information will be loaded into whichever file window is 
selected. If by accident the “Untitled1.stw” is selected, then the patch information will 
be loaded into the “Untitled1.stw” file and not added to the “Reader1.stw” file. 

3. Now select under the Stream Weaver File Menu, “Merge File Data” or <Cntl>I. As 
was done before, type the path of the Patch into the Installer Path field. 

4. Launch the Patch Installer.
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5. Once the Patch application has completed, hit the OK button in the dialog that Stream 
Weaver put up.

Figure A-1: Installation Complete Indicator

6. Now the Patch Installer information has been captured into the Reader*.stw file. Save 
this file by hitting <Cntl>S or clicking on the control bar save icon.

7. Now the Stream and Token files need to be regenerated. Select “Create Token/STC 
Files …” from the File menu. This will generate new stream files. These files should 
be tested or retested as specified in “Step 6: Test Streamed Application” on page 49.
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B
Processing Non Application Files

With Stream Weaver it is possible to process not only applications, but also documents, 
images, etc. So, for instance, it would possible to process a book whose file name is 
MyBook.pdf. However, since the command line must always specify an executable to be 
launched such as an .exe or .com file, you can’t simply specify the full path of 
MyBook.pdf because the Stream Theory Player will not be able to open it. Instead, you 
must specify on the command line a program that can open MyBook.pdf and pass the path 
of MyBook.pdf as an argument as shown in the following example:

“C:\Program Files\Adobe\Acrobat 7.0\Reader\AcroRd32.exe” “C:\Books\MyBook.pdf”

Full paths must be surrounded with double quotes if they contain spaces. 

How to specify the appropriate application for 
opening the document

To specify the appropriate application to open the desired document, we distinguish the 
following three cases.

The application is part of the operating system.
This is the simplest case since no additional files need to be processed. The application 
can be specified on the command line either without path or with full, parameterized, path, 
as shown in the following examples:

notepad “C:\My Docs\Doc.txt”
%SystemRoot%\System32\mspaint.exe “C:\My Images\Image.bmp”

Be careful not to hardcode the program folder in the case as the operating system may be 
installed in different folders on different systems (e.g. C:\WINDOWS, D:\WINNT, etc.).
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The application can be processed as part of the stream files.
In this case it would be like processing the application itself in addition to the document 
and specifying the document as a command line parameter. In the case of the MyBook.pdf 
example, for instance, you would process the Adobe Acrobat Reader along with 
MyBook.pdf and specify the command line as described at the beginning of the section.

The application can not be added as part of the stream files.
This may be the case if, for instance, the third-party application needs to be purchased, or 
if there are legal usage restrictions, etc. In this case, you can build a simple program whose 
sole purpose is to open a document, with the assumption that the end user will have the 
third-party application installed on their system. For information on how to build such a 
program, please contact Technical Support.

This program would have to be specified on the command line and take the document to 
be opened as a parameter. So if, for instance, the name of the program is Launcher.exe, 
you would do the following:

1. Follow steps 1-4 as outlined in “Processing Steps” on page 28.
2. Place the Launcher.exe file in the working folder that you specified.
3. In the Files view, right-click on the working folder and click Add File.
4. Browse to the Launcher.exe file and double-click on it, then click OK.
5. Right-click on the newly added Launcher.exe file and click Copy to Command Line.
6. The Command Line field of the Project Settings window will now be populated with 

the path of the Launcher.exe program. Add a space after it followed by the path of the 
document to be opened (don’t forget to include double quotes if the path contains 
spaces).

7. Continue to follow steps 5-10 in “Processing Steps” on page 28.
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